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End User License Agreement (EULA)

Synthox (henceforth ‘the Product’) is licensed to you as the end user.  

Please read this Agreement carefully.

You cannot transfer ownership of these Sounds and Software they 

contain. You cannot re-sell or copy the Product.

LICENSE AND PROTECTION 

1. License Grant

UVI grants to you, subject to the following terms and conditions, a 

non-exclusive, non-transferable right to use each authorized copy of 

the Product. 

The product is the property of UVI and is licensed to you only for 

use as part of a musical performance, live or recorded. This license 

expressly forbids resale or other distribution of the sounds and 

software included in the Product or their derivatives, either as they 

exist on disc, reformatted for use in another digital sampler, or mixed, 

combined, filtered, resynthesized or otherwise edited, for use as 

sounds, multi-sounds, samples, multi-samples, wavetables, programs 

or patches in a sampler, microchip or any hardware or software 

sample playback device. 

You cannot sell the Product content or give it away for use by others 

in their sampling or sample playback devices. In the event UVI 

terminates this agreement due to your breach, you agree to return 

the original and all other copies of the software and documentation 

to UVI.

UVI reserves all rights not expressly granted to herein. 

2. Protection of Software

You agree to take all reasonable steps to protect the product and any 

accompanying documentation from unauthorized copying or use. You 

agree not to modify the product to circumvent any method or means 

adopted or implemented by UVI to protect against or discourage the 

unlicensed use of copying of the Product. 

3. Ownership

As between you and UVI, ownership of, and title to, the enclosed 

digitally recorded sounds (including any copies) are held by UVI. 

Copies are provided to you only to enable you to exercise your rights 

under the license. 

4. Term

This agreement is effective from the date you open this package, 

and will remain in full force until termination. This agreement 

will terminate if you break any of the terms or conditions of this 

agreement. Upon termination you agree to destroy and return to UVI 

all copies of this product and accompanying documentation. 

5. Restrictions

Except as expressly authorized in this agreement, you may not rent, 

sell, lease, sub-license, distribute, transfer, copy, reproduce, display, 

modify or time share the enclosed product or documentation.

6. Hardware

The accompanying USB flash media is only guaranteed in it’s original 

state, as an installation medium for the Product. Any variance from 

this use including but not limited to deleting, altering or adding 

data, reformatting the media or any physical alteration of the device 

will void its warranty. If the media is found to have a physical or 

manufacturing defect please contact our support department (http://

www.uvi.net/contact-support).

 

©2015 UVI. All rights reserved.
All trademarks are the property of their respective owners.

Do not use this product until the following license agreement is understood and accepted.
By using this product, or allowing anyone else to do so, you are accepting this agreement.

http://www.uvi.net/
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Introduction

Synthox 1.5
New in version 1.5! Now includes a deep sampling of the rare 

Elka EK-44 FM synthesizer, an expanded patch library, and 

dramatically faster load-times.

The raw analog power of the Elka Synthex returns in Synthox 

1.5, this time as a versatile hybrid Analog/FM workstation! 

Synthox features a dual-layer architecture which lets you 

freely mix raw waves from the Synthex and EK-44 for a wild 

new range of sonic possibilities. Both synths were fully serviced 

then deeply multi-sampled to give you a complete range of 

raw waveforms, noise oscillators and custom patches with the 

authentic hardware character.

A widely regarded and increasingly rare analog synthesizer, 

the Synthex (1981-1985), comes from Italian manufacturer Elka 

and was made famous in part by Jean Michel Jarre. The unique 

oscillator design and lush filters in this synth pack a distinctly 

thick and raw sound. As these machines become older finding 

working units has become increasingly difficult. Now, Synthox 

1.5 brings you the very best of this instrument in a convenient 

and extraordinary sounding soft-synth.

Also included in Synthox 1.5 is a deep sampling of the Elka 

EK-44 (1986). A rare 4-operator FM synth based around 

Yamaha’s YM2203 chips, the EK-44’s raw digital sound palette 

makes a brilliant counterpoint to the Synthex and can lead to 

some truly unique sounds. From thick and sizzling textures to 

funky analog tones, digital bells and everywhere in-between, 

Synthox 1.5 is a fantastic instrument for those looking to draw 

on the classic 80’s sound of Elka.

http://www.uvi.net/
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System Requirements

Compatibility
Audio Units, VST, MAS, AAX, RTAS or standalone

UVI Workstation 2.5.11 or higher

Minimum System Requirements
  Intel CPU 

  4 GB of RAM (8 GB+ recommended) 

  2 GB of disk space

  Mac OS X 10.7 or higher

  iLok account (free, dongle not required)

Compatibility 
VST, AAX, RTAS or standalone

UVI Workstation 2.5.11 or higher

Minimum System Requirements
  Core Duo or faster

  4 GB of RAM (8 GB+ recommended) 

  2 GB of disk space

  Windows 7 or higher

  iLok account (free, dongle not required)

Authorize the Way You Want
Your license allows 3 concurrent authorizations on any combination of computers and iLok dongles.  

License management is a simple drag-and-drop process done through iLok License Manager.

Visit ilok.com/  to download iLok License Manager and create your free account.

http://www.uvi.net/
http://www.ilok.com/
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  You must have an account on uvi.net/  and ilok.com/  prior to registration

  If you purchased a physical version of this product, your serial number is located on the inside of the box

  If you purchased an electronic version of this product, your serial number will be included in a confirmation email

  You can see a list of the products you’ve registered and their serial numbers anytime at uvi.net/my-products 

1. Login to your account on uvi.net/

2. Navigate to the ‘Product Registration’ page

3. Enter your details and click ‘Register’

 Upon completion a new license will be
 deposited in your iLok account

1 2 3 4Register Your Serial NumberStep 1

http://www.uvi.net/
http://www.uvi.net/
http://www.ilok.com/
http://www.uvi.net/my-products
http://www.uvi.net/
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1. Launch iLok License Manager

2. Login to your account

3. Click the ‘Available’ tab

4. Drag the license to your computer
 or an iLok dongle

5. Click ‘Ok’ to confirm the activation

 The process is complete, your  
 device is now authorized

  iLok License Manager is required for activation, download the newest version at ilok.com/ilm.html  

  Your license allows up to 3 concurrent activations on any combination of iLok dongles and computers

  Activations can be moved between devices at anytime

» To see how many authorizations you have left simply select the license and click ‘Show Details’

» To deactivate your license, right-click it and select ‘Deactivate’ — doing so will return your license to the ‘Available’ tab

1 2 3 4Activate Your LicenseStep 2

http://www.uvi.net/
https://www.ilok.com/ilm.html
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2. Open UVI Workstation

3. Click the Settings page

4. Click the ‘Sound Banks’ tab

5. Click the ‘...’ button and select
 the folder where you’ve placed 
 your instruments

6. Restart UVI Workstation and 
  open the Browser

 Your instruments will be available  
 under the ‘Soundbanks’ tab

  UVI Instruments can be stored anywhere on your system

  Storing your instruments on a fast drive will improve performance

  Your instruments can be downloaded at any time from uvi.net/my-products 

1. Create a folder on your computer and place your UVI Instruments in it
 Once this is done we need to tell UVI Workstation where to find your instruments.

 We do this by creating a watch folder, follow the steps below to create your own:

Install Your InstrumentStep 3 1 2 3 4

http://www.uvi.net/
http://www.uvi.net/my-products
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1. Open UVI Workstation

2. Click the Browser icon

3. Open the Sound Banks tab

4. Select a product, in this example 
 we’ll choose Vector Pro, then  
 select an instrument and patch 

 Double-click the patch to load it

5. The UI appears and you’re ready to jam!

1 2 3 4

  UVI Workstation is required to run UVI Instruments

  The newest version of UVI Workstation can be downloaded free at uvi.net/downloads 

  UVI Workstation can be run as a standalone program or as a virtual instrument from within your DAW of choice

Load Your InstrumentStep 4

http://www.uvi.net/
http://www.uvi.net/downloads
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Edit Page

6Pitch

3Layer Globals

2Pages

5Layer Edit
7 Amplitude (ADSR)

7 Amplitude (...)

8 Drive

1 Presets

4 Master Gain

The UI is divided into three pages; [Edit], [Mod] and [Arp]. Primary controls such as amp, filter, stereo, pitch and effects are available on the [Edit] page. 
Clicking the [Mod] button at the top of the interface reveals the second page of controls containing the LFO and Step Modulator. The final [Arp] page 
presents an independent arpeggiator for each layer.

Main

1  Presets
Select a global preset from the pull-

down menu or browse them with the 

Prev/Next arrows

2  Pages
Change the current page by selecting 

one of the 3 options; Edit, Mod or Arp

3  Layer Globals
» On/Off Toggle

» Volume

» Pan

» Octave [+1, 0, -1]

4  Master Gain
Set the Output Gain for the instrument

Basic Controls

5  Layer Edit
» Edit 1 | Edit 2 | Edit All

Choose to edit layers 1 or 2 seperately or 

simultaneously

» Wave Menu

Choose the wave category in the first 

row and the wave in the second

6  Pitch
» Mono

Toggle between Mono and Poly voicing

» Tune

Adjust the pitch in Semitones/Cents

» Depth

Adjust the Portamento depth

» Time

Set the Glide time

7  Amplitude
» ADSR

Attack / Decay / Sustain / Release 

envelope for the Amplitude section

» No Velocity

Sets all incoming notes to max velocity

» Velocity > Attack

Modulates attack amount based on 

incoming note velocity. Low velocities 

result in long attacks; high velocities 

result in short attacks.

8  Drive
» Amount

Sets the amount of drive

http://www.uvi.net/
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Edit Page  [continued]

9Stereo

12Modwheel

10Filter
10 Filter (ADSR)

11 Effects

Basic Controls (continued)

9  Stereo
» Mode

Off / Alternate Pan / Unison

» Color

Shifts color based on adjacent samples

» Spread

Change the stereo width

» Detune

UNI Mode Only: setunes layers

10  Filter
» ADSR

Attack / Decay / Sustain / Release 

envelope for the Filter section

» Frequency

Filter cutoff frequency

» Envelope

Modifies the amount of ADSR envelope 

to be applied to the Filter

» Resonance

Adjust the resonance (Q) of the Filter

» Vel > Filter

Adjust the Velocity > Filter sensistivity

» Filter Modes

Choose Filter mode; High Pass, Band 

Pass, Low Pass or OFF

11  Effects
» Power/Amount

Choose from Phaser, Delay, and Reverb 

(additional controls available in the 

Effects page of UVIWS and MF)

12  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth

http://www.uvi.net/
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Mod Page

1Sync

5Step Sequencer

6Seq Params

2Waveforms

3LFO Controls

4 LFO Mod Routing

7 Seq Mod Routing

LFO

1  Sync
Enable/Disable LFO sync to Host Tempo

2  Waveforms
Choose LFO waveform; Sine, Triangle, 

Square or Sample & Hold

3  LFO Controls
» Speed

Change the LFO Speed

» EG Depth

Adjusts the amount of Attack and Decay 

to be applied to the LFO

» Attack

Attack time for the Speed envelope

» Decay

Decay time for the Speed envelope

4  Mod Routing
Control the amounts of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume and Filter

 

Step Modulator

5  Step Sequencer
Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

6  Seq Params
» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Smooth

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

» Res

Change the sequencers step length

» Steps

Change the amount of steps for the 

sequencer to play

7  Mod Routing
Control the amounts of modulation to be 

applied to various parameters including; 

Volume and Filter

http://www.uvi.net/
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Synthox - Arp Page

1Step Indicator

3Tie

4Layer 1 > Layer 2

5Arp On/Off

7Arp Mode

6Grid

2Step Editor

9 Steps

8 Gate

10 Octave

1  Step Indicator
LED lights up when step is triggered

2  Step Editor
16-step sequencer; affects Velocity

3  Tie
When active, step inherets Velocity from 

the previous step

4  Layer 1 > Layer 2
When active, Arpeggiator 1 affects 

both layer 1 and layer 2 (whereas 

when disabled each Arp modifies its 

corresponding layer only)

5  Arp On/Off
Toggle the Arpeggiator On/Off

6  Grid
Change the step length

7  Arp Mode
Select Up, Down, or Up and Down

8  Gate
Change the step length (knob value 

ranges from zero to the tracks 

Resolution setting)

9  Steps
Sets the Arpeggiators step length

10  Octave
Set the pitch range of the Arpeggiator 

in Octaves

http://www.uvi.net/
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Presets

00-Init

Arpeggios
AR-Analog Heart

AR-Back in Time

AR-FM A Sonic

AR-FM Busy Pad

AR-FM G Stars

AR-FM Jarre

AR-FM Minimal Beat

AR-FM Mix Down

AR-FM Multi Arp

AR-FM Paradise

AR-Hybrid Cinematic

AR-JMJ Double Arp

AR-Pop Cornox

AR-Rythm and Arp

AR-Space Caroussel

AR-Synthoxerone

AR-Universe Sound

AR-Wonderland

AR-Z Plane Airlines

AR-Zamundsens Axel

Bells
BL-BellKa

BL-Brush Bells

BL-FM Bell Template

BL-FM Mixed Bells

BL-FM Tremobe

BL-FM Tubular

BL-Happy New Year

BL-Hybrid Bells 1

BL-Hybrid Bells 2

BL-Hybrid Exil

BL-Hybrid Express

BL-Hybrid Polybells

BL-Little Porta

BL-Paper Bell

Brass
BR-B11 Wah brass

BR-B17 Brass I

BR-B18 Brass II

BR-B19 Brass III

BR-Brasspeggios

BR-FM Brass Template

BR-FM Duosonix

BR-FM Kingdom

BR-FM Soft Large

BR-FM Transonic

BR-Grace Brass

BR-Hybrid Brass

BR-Velvet Aurora

wBass
BS-Bottom B

BS-FM Bass Template

BS-FM Basstress

BS-FM Creative Wheel

BS-Funky Sub

BS-Kev Bassic

BS-One Finger Analog

BS-Ring Modus

BS-Skream Lexx

BS-Synthoxico

BS-TB Inspiration

BS-Ultra Funk

BS-Weird One

BS-Wheel Control

BS-Wheelex

BS-Whistle Sub

BS-ZanziBass

Chords
CH-Chain Lightning

CH-Circuit Jumper

CH-Determination

CH-FM Cap Andy

CH-FM Invaders

CH-FM Polysone

CH-FM Puck Monster

CH-FM Rose Valey

CH-FM Silex

CH-FM Step Pad

CH-FM Stepvolution

CH-FM The Palace

CH-FM Triade

CH-FM Wheel Me

CH-Hybrid Moving

CH-Jack Sail Air

CH-Lunar Scarab

CH-Omni Step

CH-Union Jacking

CH-Use your Wheel

CH-Variator

CH-Vulcan Trampoline

FX
FX-FM Coach O New

FX-Framheim Wind

FX-Park Six More

FX-Terra Novox

FX-The Bomb

Keyboards
KB-B15 Tremolo piano

KB-B23 Church organ

KB-B24 Reed organ

KB-B25 Electric organ

KB-B30 Metallic piano

KB-B31 Pianet

KB-B32 Funky Clav

KB-B33 Clavichord I

KB-B34 Clavichord II

KB-B35 Clavinet

KB-B36 Electric Piano I

KB-B37 Electric Piano 2

KB-B38 Chimes

KB-B39 Vibes

KB-Dream Hes Beck

KB-Dulce Organ

KB-FM Cosmopolis

KB-FM Orphing Wheel

KB-FM Piano Template

KB-FM Power Keys

KB-FM Pure Clav

KB-FM Ultra Soft

KB-Hybrid Dirty

KB-Hybrid Keythox

KB-Hyrbid Carrousel

KB-Keys and Sweep

KB-Organisation

KB-PhonKB

KB-PianoOSc

KB-Road Cruiser

Lead
LD-B12 Fat Sound

LD-B13 Metallic

LD-B14 Pan flutes

LD-B41 Sweep 2

LD-B43 Landing

LD-B46 Ring mod

LD-B49 Whistle

LD-Chorusolo

LD-Dstep Polead

LD-FM Cop Torn

LD-FM Funkytar

LD-FM Fusion

LD-FM Lead Template

LD-FM Little Tromb

LD-Hybrid Clinton

LD-Hybrid Subtle Sine

LD-Pure Sawtooth

LD-The Court Jet

LD-Therem Whistle

LD-Ultra Solo

LD-Water Drop Lead

Pads
PD-Air Dream Keys

PD-AL Jarre High

PD-B16 Chorale

PD-B26 High pass sweep

PD-BarbapaPad

PD-Deep Orbit

PD-Evolugate Wonder

PD-FM Editation

PD-FM Ethereal

PD-FM Ominous

PD-FM Pad Template

PD-FM Spectralis

PD-Glacier Veins

PD-Glycosidic Bond

PD-Hybrid Oxygene

PD-Lost Music Box

PD-Porta Sweep on Wheel

PD-Robotic Love

PD-Smooth One

PD-StePad Plaza

PD-Sweet Place

PD-Teal Voices

PD-Tender Threads

PD-Zen and Beauty

Polysynth
PL-B10 Chunky synth

PL-B40 Sweep 1

PL-B44 Wash of sound

PL-B45 Fast decay

PL-B46 Ring mod Harp

PL-B47 Phased sweep

PL-B48 Bass pluck

PL-Complextro Figures

PL-FM Poly Cruise

PL-FM Polysynth Template

PL-Grain Poly

PL-Hybrid Stack

PL-Onyx Wheel Me

PL-Synthoxic

PL-Trance Evolwheel

PL-Tri Repeater

Strings
ST-B20 Double basses

ST-B21 Cellos

ST-B22 Violins

ST-B28 Filtered chorus

ST-B29 Filtered strings

ST-Dual Layer Strings

ST-FM Harpsichestra

ST-FM Hypnotic

ST-FM String Machine

ST-FM Strings Template

ST-Hybrid Big Sol

ST-Space O Tron

Sweeps
SW-B42 Take-off

SW-FM Sweep Template

SW-Hybrid Gold Wheel

SW-Moelleux

SW-Quality Sweep

SW-Sun Glasses

SW-Ultra Sweep

http://www.uvi.net/
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  MIDI Learn

Most UVI Workstation parameters can be automated via. a convenient 

MIDI Learn. MIDI Learn allows you to bind a physical MIDI controller 

to specific parameters within UVI Workstation.

  Any FX tab parameter, Macro Knob or Slider in UVI instruments can 

use the MIDI Learn feature

  The MIDI controller type and the MIDI Channel assignment will be 

saved with the multi or with your song in the host sequencer 

  Automation is assigned per-part

To use MIDI Learn:

1. Right-click the parameter in UVI Workstation that you want to 

automate

2. After the MIDI Learn dialog appears, Trigger the desired MIDI input 

controller (knob, fader etc.)

To remove a MIDI controller assignment: 

Right-click the desired parameter and press “Delete”

  Arpeggiator

UVI Workstation comes equipped with a robust arpeggiator. To insert 

an arpeggiator in a part, you need to display the Single view in the 

UVI Workstation, then click on the note icon. The arpeggiator can 

be employed as a pattern gate, arpeggiator, or even an advanced 

rhythmic processor for your live MIDI performance or sequenced MIDI 

tracks. Arpeggiators can be inserted in an unlimited number of parts.

  Preset Stacking

Thanks to the simplicity of the UVI Workstation you can stack as 

many presets as you want by simply assigning multiple parts on the 

same MIDI channel.

  Scroll Wheel

All knobs can be adjusted with the scroll wheel on your mouse. 

When you double-click on any knob or slider, you can manually enter 

or type in the desired value.

  Split, Velocity & Key Switch

The Keyswitch settings allow you to load multiple presets into two 

or more parts and dynamically play and mute them from your MIDI 

controller using key switching, note range, velocity range or any 

combination of the three parameters. This powerful feature gives you 

a great deal of real-time control.

  Unlimited FX

UVI Workstation offers a wide variety of FX, or effect processors, 

to cover all your audio processing needs. The FX implementation is 

robust and includes the ability to insert unlimited FX slots in several 

stages of the signal flow.

  Click the “FX” tab to open the FX page on the Single view 

  In Multi view the FX section is always displayed

UVI Workstation: Tips + Tricks

http://www.uvi.net/
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Links

UVI

Home . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/ 

Download UVI Workstation and User Manuals . . . . . . . . . . . . . . . . . . uvi.net/downloads 

Your Registered Product Serial Numbers and Download Links.  .  .  .  .  .  .  .  .  uvi.net/my-products 

FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/faq 

Tutorial and Demo Videos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . youtube.com/

Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/contact-support 

iLok

Home . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/ 

iLok License Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/ilm.html 

FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/supportfaq 

http://www.uvi.net/
http://www.uvi.net/
http://www.uvi.net/downloads
http://www.uvi.net/my-products
http://www.uvi.net/faq
https://www.youtube.com/playlist?list=PLj53xz6jWjGiP7U_1y5gbrn6FrPV7DByD
http://www.uvi.net/en/contact-us
http://www.ilok.com/
https://www.ilok.com/ilm.html
https://www.ilok.com/supportfaq01.html
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